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Executive Summary 

For our entire team ETM-522, Team Building, turned out to be very different from any class we had taken 
before. It also was an incredibly rich learning experience that taught our entire team valuable lessons about 
effectively working as part of the team. Some of the education occurred in the classroom but most of the 
learning took place in our team, working on the major deliverables for the class. Through our successes and 
our failures we learned valuable lessons about working on a team. 

Introduction 

As our team started ETM 5222 none of us knew each other and we didn’t know what to expect of the class. 
The class turned out to be very different from what we expected and we learned a lot about teams, 
working as a group, cultural differences, presentation skills and especially about the other members of our 
team. We learned how to work effectively as a group from the text and lectures but also from our team 
members, especially Tom who had a lot of experience working in teams. 

Table 1 below gives a summary of our team. We had three inexperienced members, all relatively new to the 
ETM program and with minimal work experience and one team member, Tom, with ETM and work 
experience. Our team was culturally diverse, coming from three different cultures with different native 
languages, different communication styles and different cultural values. 

Team Member ETM Qtr Student Working Work Experience Country 

Apisit (M) Charoensupyanan 
 

1
st

 Full-Time No None Thailand 

Manar Al Mallak 
 

2
nd

 Part-Time Full-Time Some USA/ Iraq 

Chakaphan (Book) Pornsatit 
 

2
nd

 Full-Time Part-Time None Thailand 

Tom Shott 
 

5
th

 Full-Time No A Lot USA 

Table 1 Team Members 

Before the quarter started none of us knew each other well. Tom and Book knew each other slightly from 
being in Operations Research together last quarter. Our initial perceptions were based on interacting during 
the first class. Tom was clearly older than the other members of the team so the initial perception was that 
he was more knowledgeable. We also assumed he was experienced because he spoke about working at 
Intel during introductions. Book and Apisit are both relatively young and don’t speak English well so the rest 
of the team assumed that were smart, somewhat inexperienced and would have some difficulty with 
writing and presenting. Manar is young but speaks English fairly well and we assumed that he was 
somewhat inexperienced but good at writing English but likely not an experienced presenter. 

These initial perceptions were proven out by subsequent experiences with the exception that although 
Manar spoke English well his reading comprehension and writing was similar to the other international 
students. This directly led to the team’s failure to submit SR-4. The paper was a long academic paper and 
Manar was unable to complete the review. If the team had better comprehended Manar’s English skills 
they would have assigned an easier SR to review. 

As the quarter progressed and our team gain confidence from successfully completing tasks it learned to 
work together and moved through the four classic Tuckman team phases (Tuckman & Jensen, 1977). By 
examining how the team progressed through the stages and the key the events, tasks accomplished, 
successes, failures and team process changes and also what the team members were feeling we gain a 
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better understanding of our team’s growth and team “Best Practices”. In Appendix A Team Timeline and 
Key Events on page 3 there is a complete timeline of our team’s progress and the major events. 

In the next four sections of the paper will examine how the team transitioned from forming to performing. 
After examining this process we’ll summarize our key learnings  

Forming 

Stage Weeks Major Events Feelings 

Forming 
1  Formed Team 

 Yahoo Group, Class Roster 

 Uncertainty 

 Nervousness 

Our team formed during the first class. The reason we joined together were not very grand – we all had a 
desire to meet near downtown. 

The first class was a bit of a shock for all of us because we found out we would be teaching two classes and 
that we’d have two major papers and two major presentations to do. The foreign students were concerned 
because of the amount of presenting that would be required; Tom was concerned about the two major 
papers. 

We had time to meet in class and introduce ourselves. After looking over the syllabus we realized we had a 
very short term goal to accomplish – teaching the next class. The team was nervous about this because we 
were unsure what was involved. Our uncertainty was greater because none of us had purchased the 
required books that most of second class’s content was based upon. We also had to read and present the 
first two SR’s. Our decision was to focus on teaching the second class and worry about the rest of the 
deliverables after the second class. 

We took care of a number of important team process tasks at the first meeting. We agreed that Manar 
would be the team leader. Although people suggested Tom, he felt he didn’t have time this quarter to be a 
good team leader. Manar collected contact information for the group and we agreed on a weekly meeting 
time and place to meet every week so we would stay on track. 

The other important decision was we agreed to buy the books and read the sections for the second class 
before we meet on Saturday afternoon to prepare for teaching the class.  

After class was over, Manar compiled the contact information into a team roster and emailed it to the team 
and set up a Yahoo group for communication and sharing file. Having a hardcopy of the class roster was 
important so you always had the team members contact information. The Yahoo group was very important 
to communication and for sharing our projects. 

Overall the team had feelings of uncertainty about the class; but it was worst for Apisit. Manar, Tom, and 
Book had taken previous ETM classes but it was Apisit’s first ETM class and he was nervous due to his poor 
English and having no experience working on a team; especially when he realized that class ownership 
included teaching the entire three hour class. 
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Storming 

Stage Weeks Major Events Feelings 

Storming 2  Successfully Taught 2
nd

 Class 

 Completed SR-2 

 Fear 

 Nervousness 

Our team rapid progressed through the storming phase, moving to norming after successfully teaching the 
second class and submitting SR-2. Our immediate deliverable in the storming phase was to teach the 
second class.  

The group behavioral norms were set early in the team’s life and changed little over time. Everybody got to 
group meetings on time and finished their work on schedule. If they were going to be late for a meeting 
they texted Manar to let him know they were running late. When the class roster was first published Tom 
texted all the team members and texting became the method of communicating when a fast response was 
required. Posting a note in the Yahoo group became the way to track ongoing work and ask questions or 
raise issues. More than other members Tom would post questions or suggestions. Over time the other 
members responded more to the posts but did not initiate new topics as often. 

Tom had very high expectations for his grade and it had an impact other team member’s expected norms 
for preparing material. When the team got the first SR back in week 3 with a grade of 19 / 20 Tom was 
disappointed the grade wasn’t higher. This influenced the other team member’s perception for expected 
grades and the expected quality of the team’s work. 

The team members also compared this team to their other class teams. Overall they felt that our team was 
better organized and more professional. Everybody thought that we were doing a lot of work – but it was 
less stressfully because we were better organized and we had a schedule for the quarter. Manar thought 
his ETM-520 class was higher stress because people didn’t have clearly assigned tasks or schedule for the 
quarter. 

How the team operated changed the attitudes of the three less experienced team members and raised 
their expectations for future teams. Tom’s attitudes towards teams did not change because the ETM 522 
team had been less organized then his work experience on teams. 

Before the first group meeting was probably the low point for our team’s feelings. We weren’t sure how 
we’d accomplish our goals and the work seemed overwhelming. 

At the first team meeting we talked about how we were going to teach the first class. We discussed the 
content and decided how to divide the work. Tom and Manar understood that Apisit and Book were 
international students and let them choose the material they’d like to teach first so they could select the 
sections that would be easiest. Although Apisit and Book had been nervous about presenting after divided 
up the material they were more comfortable now that what they each had to teach was less overwhelming.  
Tom took the hardest section and agreed to present the SR’s and write-up SR-2 as he’d reviewed papers in 
other classes. 

The team agreed to get together for a dry run of the material on Monday evening and Tom scheduled the 
ETM strategy lab so we’d have a room with a projector to practice our presentations. Everyone came with 
their slides prepared and practiced the material. Everybody had feedback and good suggestions on how to 
improve the slides. Tom had a lot of feedback on people’s presentations and tried to give them suggestions 
that would improve their presentations. Everyone uploaded their slides to the yahoo group and Tom 
applied the ETM template, cleaned up and merged the slides. 
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Just before the second class was when Tom felt the worst about the class. He was concerned that the other 
team members would present poorly and hurt his grade. 

Teaching the second class went well. The presentations went well and Prof. Dryden and the class felt we’d 
done fairly well. The team felt a sense of accomplishment because they’d completed a challenging task. We 
all felt good because we’d been the first team to teach and because even though the presentations were 
not all perfect, everybody had improved from the dry run and felt they had performed at the peak of their 
ability. 

Norming 

Stage Weeks Major Events Feelings 

Norming 3 – 4  Map Day 

 Choose Research Topic 

 Confidence 

We entered the Norming phase feeling a lot more confident about our ability to work together as a team 
and get a good grade in the class. Teaching the second class, having it go well and getting feedback that we 
had done well boosted our confidence and gave us a shared sense of accomplishment. We also got SR-2 
back in week 3 and found out that we had received a 19/20 on the review. Tom was mildly disappointed 
that we had not gotten a 20 but the rest of the team was very happy with how we had done – further 
boosting our shared sense of accomplishment and confidence. 

During the norming stage, our roles in the team became clear. Manar was the team leader who was made 
sure we had an agenda before we meet, encouraged us all to participate and keep things moving. Tom had 
declined to be team leader and acted as a mentor for the team, making suggestions, providing training and 
giving feedback but not directing the team or deciding what we should do next. Book and Apisit, as 
inexperienced international students contribute by committing to their assigned tasks, submitting them on 
time, participating in every meeting, and doing their best to help the team succeed. 

There were both formal and informal forms of influence within our team. Manar exercised formal influence 
through his position as team leader giving him legitimate power. He also had informational power since he 
generated the agendas and published the minutes for the meetings – so he could influence how people 
interpreted the discussions and decisions. For example Manar suggested that Tom and Book do the 
research presentation and Manar and Apisit do the team process presentation. Because he was the group 
leader the rest of the team agreed to this split. 

As a more experienced team member Tom had informal expert power within the group. Team members 
listened to his suggestions and tend to accept his opinions without questioning them. The second week of 
class Tom suggested that we do a map day. The rest of the team didn’t see the need but they trusted Tom’s 
recommendation that it was necessary. 

One team process that was very valuable was having a Map Day in the third week. (Detailed instructions for 
a Map Day are in Appendix B Map Day Instructions on page 5). Although Manar was not convinced of the 
value of a Map Day – Tom talked him into it. All of the team members contributed in planning the tasks 
required to complete our deliverables, and determining what week they need to be done and who owned 
them. Because the whole team participated in the planning they had a better understanding of the tasks 
and when they needed to be completed to stay on schedule. Manar used this team task sheet the 
remainder of the quarter to track what needed to be accomplished each week. 
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Two very effective techniques we learned from class was creating a team charter with ground rules and 
using Normative Group Technique (NGT). We completed a team charter which made our team goals and 
ground rules clear. We used NGT effectively to decide on our research topic. 

Not all the team processes were going well. Book reviewed SR-3 in week 3 and finished it by Friday but Tom 
didn’t review it until Tuesday morning. Because he reviewed it late he was forced to spend three hours 
editing it himself before submitting it instead of giving Book feedback early and enabling him to make the 
corrections. 

The communication patterns for the team were established by the second week of the class. Manar acted 
as the hub for team communications. He’d often talk to individual team members to resolve issues. During 
face to face meetings everybody would contribute but Manar and Tom tended to contribute the most.  
Manar worked hard to draw Book and Apsit into the group discussions and ask their opinions so they would 
contribute. Tom tried to restrain himself and not express his opinion too often or too strongly – but he had 
a hard time keeping quiet when he a strong opinion on a topic. The problem was that other team members 
tended not to challenge his opinion so there was little collaboration or collective problem solving once Tom 
had expressed a point of view since the other team members assumed he was right. 

Often times if Tom had an idea or thought something was important he’d text Manar and then they’d 
discuss it. Manar would then talk with the other team members when their assistance or buy-in was 
required. Likewise Book and Apsit tended to call Manar when they had a problem or question. When Book 
was having difficulties enter references in End Note he spoke with Manar after a team meeting to get help. 

As the team moved into the norming stage we felt like we understood each other better as we had spent 
time two or three times a week working together as a team doing exercises in class and working in our 
group meetings. Everyone had a sense of working in a team and was committed to the team’s success. We 
knew what each of us need to do by following the team task sheet. The whole team felt more confident 
about completing our deliverables and clearly knew what their role and tasks were. 

Performing 

Stage Weeks Major Events Feelings 

Performing 5 – 10  Research and Group Process papers 

 Final presentations 

 Completed 3 SR’s 

 Confidence, Trust 

Our team transaction to the performing stage around week five. The team was communicating better, 
there was greater trust and we were working more effectively. 

The higher level of effectiveness and trust enabled the team to effectively deal with a number of issues that 
came up during this phase. The team had a major disagreement on the research topic due to poor 
communication. Tom though the paper was on the impact of culture on out sourcing while the other team 
members thought that the paper was on the impact of culture on teams. The misunderstanding took place 
because the topic had never been written down – in verbally communicating about the topic we had 
misunderstood each other. The team resolved the problem by coming up with the compromise research 
topic of international task forces. This enabled the majority of the team to use the research they had 
completed but forced Tom to redo some of his research. The effective communication and trust enabled 
the team to get the problem resolved quickly by phone once it was discovered. 

Another crisis towards the end of the quarter was when we were surprised to discover the final research 
paper was due a week earlier than we had thought. The team leader had not been tracking the key dates 
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and the team had been depending on him to keep them on track. When we discovered that we had a week 
less than planned to complete the paper we all chipped in where we could and pulled the paper together. 
The team was able to overcome this obstacle and archive a decent research paper. 

A problem the team overcame was failing to submit SR-4. Manar had the task of reviewing this very difficult 
paper. He was unable to complete a decent review in time for Tom to do final edits so the effort was 
wasted. The team looked over the available papers and choose an easier paper to replace SR-4. They 
communicated about the problem, came up with a solution and worked together to overcome it. 

The team worked very effectively during the final part of the quarter. It took less than half the work to 
prepare for teaching the sixth class. We only required one meeting to have a dry run for the material and 
provide feedback on the slides. The international students were more comfortable presenting the second 
time since the first time had gone well. 

Our team leader had a better idea of our strengths and weaknesses. He was able to assign tasks based on 
people’s strengths. He noticed that Apisit was good at finding pictures for presentations – so he asked him 
to do this for the team process presentation. Likewise he had realized Tom was a good presenter and 
assigned him the more challenging sections of the final presentations. 

The team had no formal reward system but there were informal rewards. Both Manar and Tom gave 
positive and sometimes negative feedback to team members. For example after the research presentation 
Tom gave Book feedback that he had done a good job - the complement was an inform reward. 
Complements were the primary form of reward within the team. 

There was frequent communication between the time members. The rate of posts was much higher as 
people communicated via our yahoo group and shared ideas and suggestions. This higher level of 
communication also helped to build cohesiveness and trust within the team.  

The higher level of communication and trust allowed us to be more flexible about getting work 
accomplished. People could swap tasks back and forth and tasks could be reassigned to even out the 
workload. When a team member fell behind on a larger task they were willing to ask for help without 
feeling shame or avoiding the conflict. Also if a team member had an idea or a suggestion but didn’t have 
time to work on it – they could raise the idea to the team and see if somebody else could work on it. Tom 
was working on finishing the research paper and realized he would not be able to continue working on it if 
he had to print it before he left for class. He posted a request for help and Manar volunteered to print the 
paper 10 minutes before class so Tom could continue editing. 

Lessons Learned 

Through our success, and perhaps more through our failures we learned many lessons on how a team can 
work effectively. 

The team should collect information for the team roster at the first meeting with both email and phone 
contact information in case there is a typo in one of them. The roster should be mailed out and all the 
members should print and keep a hard copy so they always can contact the other team members when 
required. We found this vital when you weren’t near a computer and had to contact other team members. 
The team should also setup an online group for sharing files and posting messages. This way it’s always 
easiest to find the latest version of an assignment and all the messages related to the team are stored in 
one spot. This worked well for our team and we could always find the latest version of a document to work 
on. 
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The team should decide on a time and place to meet every week when they first got together. It’s 
important to find a time and place that works for everybody every week. We didn’t have to spend time 
trying to figure out when and where to meet each week. It was also important to meet every week – even if 
a major assignment wasn’t due. This helped us to bond as a group and to keep us on track getting work 
done. It also gave us a chance to work out minor issues face to face each week. 

It’s important to do a team charter and agree on team ground rules early in the quarter. Having these 
helped ensure we all behaved as expected. 

We found that team meetings were more productive when Manar mailed out an agenda a few days in 
advance and when we stuck to the items on the agenda. Reading the agenda before the meeting helped us 
make sure we were prepared for the meeting. After Manar started sending out agendas in the middle of 
the quarter our meetings were more effective. Also having somebody send out the minutes of the meeting 
within a day keeps everybody on the same page about what was decided. It helped the international 
students understand what had been deicide if they weren’t sure. Other key decisions should also be posted 
online. If we had written up and posted our research topic earlier there wouldn’t have been confusion over 
our research topic. 

Have a Map Day early in the quarter to plan how the team will accomplish its goals. By breaking larger tasks 
up into week long chunks it’s easier to keep people moving throughout the quarter. Having the task 
planned out for the quarter saved our lives a number of times. Because we had mapped out what had to be 
done, and started early we had some slack in the schedule. We were able to handle the research paper was 
due a week earlier then expected and failing to complete a SR because we had already done a lot of work 
and we had some slack in the schedule. It also helps build team cohesion and understanding as everybody 
knows what has to be done and how their parts fit into the overall projects. It also builds commitment to 
the team. 

If the class has a research paper the team should setup a shared End Note Web folder at the beginning of 
the quarter and ensure everybody is trained on using End Note Web. Tom trained the team on using End 
Note Web (see Appendix C End Note Web Instructions on page 8) and Manar maintained the references 
and made sure everybody was entering their references as they were finding them. Because everything was 
entered as it was found it was easy to insert the citations into the final paper. 

If a class has SR’s the team should review the SR’s quickly at the start of the quarter before deciding which 
ones to review. Because we failed to review the SR’s we chose some of the hardest ones to review and 
failed to complete two write-ups. It would have been better to pick the five easiest SR’s at the start of the 
quarter and assign each SR to the appropriate team member. 

Conclusion 

ETM-522, Team Building, was a valuable class in learning how to work as a team. It was most valuable for 
the less experienced team members without little experience working in a team. They learned valuable 
teamwork skills from the texts, class, working in our class team and from Tom. For Tom it was a refresher 
for what he had been taught in Intel training and leadership classes. The team overcame the challenges of 
poor presentation and English skills to do four good presentations and write two good papers. 
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Appendix A Team Timeline and Key Events 
 

Stage Week Feelings / Events 

Forming 1 Nervousness, uncertainty 

 Process: Group Formed 

 Process: Agreed on weekly meeting time 

 Process: Set individual goals for first meeting 

 Process: Yahoo Group Set 

 Process: Class Roster Published 

Storming 2 Fear 

 Event: Found out Charlie not back in time for class 2 

 Process: Split up teaching  

 Process: Dry Run 2nd Class 

 Process: ETM Presentation Template 

 Process: Version number files 

 Deliverable: Prepared & Taught 2nd Class 

 Deliverable: Submitted SR-2 

 Task: Failed doing SR-1, didn’t submit 

 Process: Wrote team charter 

 Task: Tried using name cards for class participation, failed 

Norming 3 Confidence 

 Event: Kam joined and quit group 

 Event: Found out Charlie would not be back this quarter 

 Event: Found out got 19/20 on SR-2 

 Process: SR Review Template Posted 

 Process: Map Day – planned quarter’s tasks 

 Process: Used NGT to choose a research paper topic 

 Deliverable: Team charter 

4  Process: Dealt with meeting schedule change 

 Task: Completed first paper summaries for research paper 

 Process: Failed giving timely feedback SR-3 

 Deliverable: Submitted SR-3 

 Process: End Note Web training & setup 
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Stage Week Feelings / Events 

Performing 5 
Trust, confidence 

 Event: Found out got 20/20 on SR-3 

 Process: Word Training 

 Event: Found out team had misunderstanding on research topic 

 Deliverable: Abstract & TOC for research paper 

 Task: Second set of paper summaries 

 Task: First drafts sections of research paper 

6 
 Task: Failed submitting SR-4 

 Process: Planned to teach 6th Class 

 Process: Dry Run 6th Class 

 Deliverable: Prepared & Taught 6th Class 

 Task: Revised sections of research paper 

7  Deliverable: Submitted SR-5 

 Task: Combined draft research paper 

8  Task: Revised version of research paper 

 Deliverable: Submitted SR-6 & SR-9 

 Deliverable: Submitted Research Report 

9  Process: Dry run the two presentations 

 Task: Draft sections of group process report 

 Deliverable: Presented Research Report 

 Deliverable: Presented Group Process Report 

Table 2 Team Timeline 
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Appendix B Map Day Instructions 

A map day is a way of a group interactively determining the schedule for a project. 

The major sections for a map day are determining the goals for the project, listing tasks required to 
complete the goals and schedule the tasks for the quarter. 

Because the process is an interactive group process everybody gains a better understanding of what needs 
to be done and how the tasks are interdependent. 

Defining Goals 

The first part of the map day is determining the goals for the project. What are the major deliverables? 

A good starting place is working from the class syllabus. 

We’ll write up on different sections of the white board the major goals for the project and talk about what 
the major deliverables are. We’ll want to refer back to the syllabus and make sure we have all the major 
parts of the projects included. 

Defining Tasks 

Next we define all the tasks to complete each goal. Each task gets written on a 3x3 post-it and stuck on the 
white board under its Goal. 

On each post-it we write the task in big letters at the top and smaller in the middle the post-it we write 
what goal its part of. If the task is a final deliverable like presenting a final presentation, we write the week 
it’s do on the bottom right of the post-it. The bottom left of the post-it we leave blank. 

So we can all collaboratively brainstorm and think of all the tasks need to be completed. We can talk about 
it; make sure we have all the tasks listed. 

Doing a paper review is probably a task by itself. Doing a presentation might include 3- - 5 tasks, doing a 
outline, team members each doing their section, having a dry run and doing final presentation integration 
and cleanup. 

As a general guideline each task should be a week or less to complete. It’s easier to keep team members on 
track if they have tasks to complete and post each week so everybody can tell they are on track. 

Scheduling Tasks 

We draw up a grid on the white board with a column for each week in the quarter. Then we go about 
scheduling each of the tasks.  

We start with all the tasks that are deliverables and have class due dates, these get stuck on the white 
board under the week they are due in. 

Then the tasks required to complete the deliverable stuck up in weeks prior to the deliverable being due. 

Now look at the white board and make sure there are not too many tasks being done in one week. Spread 
out the work so it’s even throughout the quarter. 
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Assign Owners 

Now go through each post it and figure out which team member will do it. Based on each team member’s 
skills, interests and available time assign each post it to a team member. Write their name in the lower left 
corner of the post-it. 

Take a look at all the post it again and make sure no team member has too much to do in one week. If need 
be either move the task earlier in the schedule or assign it to a different team member to even out the 
work load. 

Documenting Schedule 

Now we have to record the tasks and document the schedule. 

First we go through all the post-it’s and write the week its being done in on the lower left corner of the post 
it. 

One by one we take down the post-it, and record the information in excel. We record the task, what goal its 
part of, who’s doing it and what week it’s being done in. That way we have a record week by week for the 
quarter of what needs to be done. 

You now have a team task list that lists every task that needs to be completed that quarter, what week it’s 
being done in and who’s doing it. 

Roles 

There are some assigned roles to keep the whole process going. 

 Time Keeper – this person has a copy of the agenda and lets us know where we are on time. Five 

minutes before we are done with each section of the agenda the time keeper warns us that we 

have five minutes left. Then they have to tell us we have reached the time limit for an item on the 

agenda. Requirement is that the person has a watch. 

 

 Rat Hole Preventer – a rat hole is when we get stuck talking (arguing) about one topic for too long. 

It’s either a topic that’s a minor topic and doesn’t disserve so much attention or it’s just a topic that 

won’t get resolved in this meeting so it should be postponed. If the topic is important and shouldn’t 

be forgotten, then the gate keeper writes it on a “bin” list on the white board. Requirement is that 

the person has a soft object (kosh ball, paper wad) to toss at the person who’s talking too much 

about the topic. 

 

 Gatekeeper – it’s important to make sure everybody in the group talks and contributed. If they 

notice that somebody is not contributor then they ask that person a question to get them to talk. 

This draws everybody into the discussion. 

 

 Minute Taker – they keep the minutes in word for the meeting. Requirement a laptop and being 

able to type fast in word. 
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 Schedule Recorder – they record the final schedule in excel. After the schedule is done they record 

the information for each task. Task name, what goal attached to, what week to be done in. 

Requirement is a laptop and being able to type fast in excel. 
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Appendix C End Note Web Instructions 

Why EndNote? EndNote web has two great reasons for using it. It’s a good way for a group to share 
references online and see what resources people are using & finding. The second is it makes inserting and 
formatting the bibliography for a paper trivial. For some classes not a problem – but other professors are 
strict on correct bibliography format. 

Notes about the rest of this tutorial. I’m writing this logged into the PSU network via VPN – so if you’re not 
getting exactly the same thing I am – you might want to try on campus or try via logged in by VPN. It should 
work ok if you’re not – it may just prompt you at some point for your ODIN login info. 

(Directions to log into PSU network via VPN http://www.cat.pdx.edu/windows/maseeh-college-vpn.html, 
you will need a engineering computer account ) 

Signing Up For EndNote Web and Initial Configuration 

Most of this info can be found just off the PSU Library home page. 

Signup for a EndNote Web account 
1. Go to the PSU Library Homepage http://library.pdx.edu/ 

2. Go to the PSU Library EndNote Web Page http://library.pdx.edu/endnoteweb.html 

3. Go to the EndNote Web site http://www.myendnoteweb.com/ 

4. Signup for a new account 

(Note:  You MUST use the same email address to sign up as is on the class roster – because that’s the email 
address I shared the folder with). 

Initial Setup 
1. Go to endnote web & login 

2. Go to Options -> Profile to set things up 

3. Go to Options -> Download Installer 

4. Download the Internet Explorer plug-in – even if you don’t use Internet Explorer you’ll need it 
because it includes the Word Plug-in to insert and format references and the bibliography in your 
word doc. 

5. Optional Download and install the plug-in for Firefox 

Make sure you can see the shared team Folder 
1. Go to Organize -> Others' Groups 

2. Make sure you can see the team Folder that I’m sharing with you – you have read / write access. 
This also means if you mess up and delete all the references you wipe them out for everybody – 
don’t say I didn’t warn you. Note that you need to use exactly the same email that was on the 
roster – that’s what I used to share with you. 

http://www.cat.pdx.edu/windows/maseeh-college-vpn.html
http://library.pdx.edu/
http://library.pdx.edu/endnoteweb.html
http://www.myendnoteweb.com/
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Setup formatting – setting up default Bibliography Style for the class 
1. Go to Format -> Bibliography 

2. Choose “Customize This List 

3. Add “IEEE” (it’s at end of long list IEEE styles) to My Favorites 

4. Add “APA 5th” to My Favorites 

(Note: These are the two most common ETM styles.) 

Optional: Configuring Google Scholar 

If you use Google scholar for research – then it’s worth configuring it to export references into End Note 
Web. 

Go to http://www.endnote.com/support/enwfaqs/Import/faq12.asp 

Using End Note Web 

OK – now you’ve got EndNote setup – let’s see what it can do. 

Add a Reference from a literature search 

The easiest way to add a reference is one from a literature search database. I’ll use Web Of Science as an 
example. This works well – but recently Business Source Premier stopped working for no apparent reason. 

1. Go to the PSU Library ETM Research Page 
(http://www.lib.pdx.edu/guides/resources.php?category=21)  

2. Go into Web Of Science and search for a article 

3. Once you’ve found a reference, check the box and then at the top of the page click “Save To 
EndNote Web”. 

4. Go to EndNote, My References, and click on the “Unfiled” item under My References in Panel on 
left side of page. 
You should now see a list with only one reference, the one you just added. 

5. If you think this is a good one for the project, check the box and select Add to Group Folder and it 
will be added to the shared folder. 

Adding a Reference from a web page 

If you’ve installed the Internet Explorer or Firefox add-in you can also grab info off a web page. I’ll use this 
to add a book from the PSU catalog. 

1. Go into Business Source Premier. 

2. Find an interesting paper and go to the detailed citation view for the paper. 

3. Click the “Capture” icon on the EndNote Web Toolbar 

http://www.endnote.com/support/enwfaqs/Import/faq12.asp
http://www.lib.pdx.edu/guides/resources.php?category=21
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4. It should pop up a window that it’s partially filed in from the information on the page. 

5. Make sure the correct type of Reference Type is selected and then fill in / correct the required 
fields (have red stars). 

6. Click Save to EndNote Web at the bottom 

Displaying / Formatting Your List of References 

So once you have a list of references, you can go ahead and print a list. 

1. Go to Format -> Bibliography 

2. Choose the folder of references, type (APA 5th), and select file format HTML. 

3. Click Preview & Print 

4. Now you can print or cut and paste into an email or document the list. 

Adding Citations & Creating Bibliography 

OK, you’ve entered all your references in EndNote and done all your research, now you want to start 
writing and insert citation. So there are a few requirements. You need to have downloaded and installed 
the EndNote Web Internet Explorer add-on – it also does the word citation insert. You also need to be 
online while you’re writing. 

Initial First Time Setup 
1. When you open word you should see the EndNote Web toolbar. 

2. Open EndNote Preferences 

a. Under Application fill in your account email for endnote and password 

3. Open EndNote Format Bibliography 

a. Under Format Bibliography set output style to IEEE 

b. Under Layout set Bibliography title to Bibliography 

Insert Citation 
1. In your paper, go to where you’d like to insert a citation 

2. Click the EndNote Search icon, enter a few keywords for your citation, title, author, date – it will 
search the EndNote database for your reference. 

3. Select the right reference, and lick insert. [1]. 

4. A citation should be inserted in the text (Note: these are inserted as “field codes” – they aren’t 
normal text, you shouldn’t try and modify them like normal text). 
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5. If this is your first inserted citation EndNote will add a Bibliography section to the end of the 
document and automatically add all the references used and alphabetize the list. 

Using a Reference a second time 
1. When you use the reference second time [1] you can search again and insert the same reference. If 

you’ve used the reference before it’s smart enough to know to use the same reference number. 

Inserting References Offline or Cite While You Write Plug-in not Installed 

You can add references when your offline, or even when you haven’t entered them into EndNote Web yet.  

1. In your text use { and } around your information. Inside the brackets you can use the last name 
author, year of publication. Or author and part title. {Shott, 2009} 

(Note:: See http://www.myendnoteweb.com/help/en_us/ENW/hs_formatpaper.htm for more 
information on how to embed information offline.) 

2. Now, when your online and have the cite while you write plug-in installed. Click on the Format 
Bibliography button and it will and find all the references and ask you to ok or ignore the reference. 
[2] 

 

 

http://www.myendnoteweb.com/help/en_us/ENW/hs_formatpaper.htm

